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License Agreement
This package contains your FEWeld program.  Please read this agreement before installing the software.  If you do not
agree with the terms of the agreement, return this package as is and Weaver Engineering Co. will, upon receipt, refund
your purchase price.  No refund will be made for packages returned with missing or damaged components.

1. License:  Weaver Engineering Co. grants you a nonexclusive right to use the enclosed program.  The enclosed
program may be run on only one computer.  This license may not be transferred without the written authorization of
Weaver Engineering Co.
You may not:  (a) distribute copies of the program or user manual to others; (b) provide, sell, or sublicense access to, or
use of, the program to other third parties; (c) modify, use, copy, reverse assemble, reverse compile or transfer this
program or user manual, or any copy thereof without prior written consent of Weaver Engineering Co.
You may:  make copies of this program solely for backup purposes.  Such "backup copies" must be so labeled.
2. Copyright:  This program and user manual is protected by a copyright which is owned by Weaver Engineering
Company.  You may not copy the program or user manual except for the purpose of backup, as stated above, and to
load the program into a computer for executing the program.  All other copies of the program and user manual, except
as stated herein are in violation of this agreement and Weaver Engineering Co.'s copyright.
3. Term:  The term of this license is effective until terminated by your failure to comply with this agreement and Weaver
Engineering Co.’s copyright.  You may terminate the license by destroying the program, user manual, and all copies
thereof, and returning any security devices along with written notice to Weaver Engineering Co. of such termination.
4. Restrictions:  This program contains software and technical data that is subject to the export laws, orders and
restrictions of the United States.  You may not directly or indirectly import, export, re-export, transship, or use the
program in any country or destination that requires an export license, other approval for export, or is in any way
contrary to U.S. laws, without having obtained such permission.
Any license to the U.S. Government is subject to the restricted rights as stated in the following documents and any
amendments and successors thereto:  For the Department of Defense, DFARS 252.227-7013, Rights in Technical Data
and Computer Software; DFARS 252.227-7037, Validation of Restrictive Markings on Technical Data.  For the National
Aeronautics and Space Administration, NFARSUP 18-52.227-19, Commercial Computer Software - Restricted Rights.
For other civilian agencies FAR 52.227-14, Rights in Data - General and FAR 52.227-19 Commercial Computer
Software - Restricted Rights.  These clauses are incorporated into this agreement by reference, with the same force
and effect as if they were given in full text.  In no case however, will any interpretation or modification of these clauses
grant you any rights in the enclosed software or data beyond those of using it under the terms of the remainder of this
agreement.
5. Limited Warranty:  (a) Weaver Engineering Co. warrants that the CD-ROM upon which the enclosed program is
recorded is free from defects in materials and workmanship when used under normal conditions, and (b) Weaver
Engineering Co. warrants that the program will perform substantially as described in the User Manual.
6. Disclaimer:  Weaver Engineering Co., its agents, employees and distributors shall not be liable for technical,
editorial, or other errors or omissions which may be contained in, or the negligent preparation of this material.  Weaver
Engineering Co. hereby disclaims any express or implied warranty that the enclosed software, documentation, or other
materials are fit for any particular purpose.
Weaver Engineering Co., its agents, employees and distributors shall not be liable for compensatory, punitive, or other
damages of any nature, arising from, or allegedly arising from any breach of the Limited Warranty above, nor shall they
be responsible for claims for lost profits or revenues, lost data, or recreating lost data, substitute programs, nor any
claims of third parties.  This disclaimer shall apply regardless of any notice to Weaver Engineering Company of the
possibility of such damages.
7. Exclusive Remedies:  Upon breach of the Limited Warranty, stated above, Weaver Engineering Co. shall at its
option:  (1) provide a corrected program to you, or (2) provide a corrected User Manual, or (3) refund the fee paid for
the program, without charge to you.  In no case shall Weaver Engineering Company's liability exceed the amount of the
license fee paid, or $100 (U.S.), whichever is greater.  These are the exclusive remedies agreed in case of breach of
the Limited Warranty.
8. Acknowledgement:  You acknowledge that you have read this agreement and are bound by its terms, that this
agreement is the complete and exclusive agreement of the parties hereto, and that it supersedes any and all
communications, proposals, representations, and agreements, oral or written, previously or subsequently made
between the parties.  This agreement shall be enforced and interpreted in accordance with the laws of the State of
Washington and applicable laws of the United States.  If any provision of this agreement is determined to be invalid or
unenforceable, the validity or enforceability of the other provisions shall not be affected.
9.  Notices:  All Notices required by this agreement, questions pertaining thereto or concerning the enclosed program
and User Manual should be directed to:

Weaver Engineering Company
150 Nickerson Street, Suite 102
Seattle WA  98109
U.S.A.

Install this software only if you agree to the terms of this License Agreement
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Chapter 1.    FEWeld Overview

1.1. What Is FEWeld

FEWeld is a general mathematical tool for calculating weld parameters to meet performance
criteria from the results of finite element analysis with shell elements1.  It’s primary use is for
performing calculations on linear welds – fillet welds, groove welds, and with special
consideration, seam welds.  Spot and plug welds are currently not supported.

Chapter 3, Theoretical Overview, provides a full description of the mechanics behind FEWeld.  In
short,  FEWeld calculates joint design parameters whose values determine the predicted
performance of the weld with respect to design requirements.  For example, the throat size of a
fillet weld is a joint design parameter while throat shear stress may be the predicted performance
and the throat shear allowable the performance criteria.  At each node2  of each weld joint, for
every load case, FEWeld extracts the loads transmitted by the joint as well as the full stress state at
both sides of the element in terms of the local weld joint coordinate system.  This information, in
addition to the part thickness, is fed into the “Weld Formulation” a standard or user defined set of
mathematical expressions that characterizes the performance in terms of weld parameters and
calculate parameter values that meet the performance criteria.  The formulation can solve either
explicit expressions for the design parameters from the load and/or stress data or there is a
constrained goal seeking facility for more complex formulations.3

FEWeld is implemented as a database which enables rapid evaluation of configuration variations
and organizes large models with numerous load cases effectively. Detail and summary output are
available in report format or readable into spreadsheets for further analysis.

FEWeld is not a finite element analysis package.  FEWeld currently works with ANSYS and
COSMOS/M finite element analysis packages.

While FEWeld’s primary use is for calculation of weldment performance with respect to code
requirements, FEWeld is not a “Code in a Box” – sound engineering judgement and understanding
of the problem at hand are required for successful use of this tool.  To that end, the formulations
that are provided with FEWeld have descriptions of what they are – i.e. “Single Sided Weld based
on Throat Shear” with no direct reference to code applicability.  It is up to the user to make the
appropriate characterization and define the performance criteria for the situation

1.2. Who is it For?

Successful use of FEWeld requires an understanding of weld performance characterization and
experience in finite element modeling.  The user should have a strong background in mechanics of
materials (a.k.a. strength of materials), familiarity with welding and weld joint design, and have
full understanding of the performance requirements (i.e. code) against which the weldment is
being designed.  These abilities need not rest with one person.  It is plausable for a fea analyst to

                                                
1 Shell Elements:  Sometimes called Plate Elements.  They are three and four sided elements with no geometric
thickness (like a surface) – the thickness is supplied as a property.  They siimulate both in-plane and out-of plane loads
and are good for representing structural shapes, plates, piping, etc.  See Chapter 3.
2 Nodes are located at the corners and possibly the midsides of each element in a finite element model
3 Expressions of the following form can be calculated {Iterate the weld_size, calculate the weld stress, minimize the
weld area such that the calculated stress is less than or equal to the stress allowable and the weld size is greater than or
equal to the minimum weld size.}
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build and run the model, while the weld joint person develops weld formulations, evaluates results,
and makes recommendations.

1.3. Background,  Current State, and Future

1.3.1. Background

FEWeld was originally developed at Weaver Engineering as an in-house tool for evaluation of
weldments against the AWS structural welding codes – determination of throat shear and weld size
requirements from the results of finite element analysis.  This enabled us to gain the benefits of
load path predictions of finite element analysis for complex structures and apply the classical weld
load – throat shear formulations upon which the code allowables are based.

FEWeld originated as a command-line tool and the analysis was labor intensive for complex
structures where the configuration was undergoing iterations.  This original configuration had
hard-coded formulations for single sided welds (fillet or partial penetration groove), double sided
fillet and double sided partial-penetration groove welds.  It could only handle straight welds (no
pipe or formed sections). Circa 1995.

1.3.2. Current State

The current FEWeld handles general joint geometry (pipe connections, etc), provides a database
driven GUI for entering the weldment configuration data, performing the analysis and evaluating
the results.

There is a Weld Formulation editor that uses a simplified ‘c’ like mathematical language that
allows for very general weld formulations based on loads, stresses, orientation and geometry.  The
formulation can specify user inputs for each weld (such as skew angle, prep size, restraint) that are
then incorporated into the GUI for parametric weld definition, and outputs are designated as the
results of the calculation for charting, summary reports, and export.  Each weld in the database has
one formulation associated with it.

Load cases are included in the database.  In the simple case, a stress ( or load) allowable is
specified for each load case.  For more complex situations where different parts of the structure
have different allowables under the same loading, multiple ‘allowables sets’ can be defined, each
with it’s own value for each load case.  Each weld is then associated with one allowables set.

Each FEWeld file can accommodate multiple configurations (associated with multiple fea models)
for rapid comparison between design iterations.

FEWeld generates concise, professional reports of the configuration definitions, results summaries,
and detail results formats.  There is a chart browser which easily cuts through the data by load
case, by weld, or by configuration.

The configuration definitions, results, and a copy of the formulations used for the calculations are
stored in the FEWeld file.  This is important for archiving and maintenance of definition integrity.
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Chapter 2.   Installation
NORMAL INSTALLATION (Windows NT4, 95, & 98 )

If you have FEWeld installed, delete the 'setup' directory that exists  as a subdirectory of your
installed FEWeld program directory before running the update file. The installation will not
work if you don't.  ( Un-install and update did not work with previous FEWeld releases ).

FROM CD-ROM

Execute Setup.bat on the CD or Setup.exe in the 'Program' directory of  the CD.

FROM FTP UPDATE DOWNLOAD

The download, 'FEWeld_Update_DD_MMM_YYYY.exe' is a self extracting .zip  file that
unzips the install files and launches the installer upon  completion. If you cancel the setup,
run setup.bat from the directory  where you unzipped the files.

Note for MS Access 2000 Users:

90% of the time, FEWeld will install correctly on computers that also  have Microsoft
Access 2000 (Part of MS Office 2000 Premium) installed.

 For the other 10%, when FEWeld Starts, MS Access 2000 try to will open it,  and you will
get a message asking if you would like to convert the  file, which you can't do. In this case,
copy the FEWeld.mde file that  is included in the
'If_It_Doesnt_Work_Out_of_The_Box_With_MSAccess2000'   subdirectory of the
'Program' directory of this distribution to the   FEWeld program directory on your
computer .

WINDOWS 2000 INSTALLATION:

FROM CD-ROM

Run the Setup.exe contained in the 'Program_for_w2000' instead of the 'Program' directory.

FROM FTP UPDATE DOWNLOAD

The download, 'FEWeld2000_Update_DD_MMM_YYYY.exe' is a self extracting .zip  file
that unzips the install files and launches the installer upon  completion.

 Note for MS Access 2000 Users:

For the windows 2000 installation, if you have MS Access 2000 installed  but not the
'Graph' office tool installed, FEWeld charts will not work.  You will need to install Graph9
from the installation disk that MS Access  2000 came on. (If MS Access is not installed, this
is not an issue.)

Refer also to the ‘Readme.txt’ on the cd-rom or download for update information.

2.1. System Requirements

� Pentium Processor

� Windows 95/98, NT 4.0 or 2000.

� 20 MB Free Hard Disk Space for Program

� 64 MB Ram Recommended
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2.2. Getting Started

You are strongly encouraged to read the entire manual and work the example problems before
using FEWeld for earnest engineering work.

2.2.1. Licensing

You must obtain a license key before you can run FEWeld outside of evaluation mode.  To do this,
you need to provide Weaver Engineering with the host id of your computer.  This id is based on
the network card you have installed.

FEWeld comes with a utility program for obtaining the host_id called gethost.exe, which is
installed in the FEWeld application directory.  Running this program will create a file called
host.txt in the same directory.  Email or fax the contents of this file to Weaver Engineering and we
will send you your license string.  If it is via email, it will be attached as license.txt.  Copy this file
to your FEWeld application directory.  If it is faxed, create a file called license.txt in that directory
using a text editor such as Notepad, and type in the license string exactly as given.

FEWeld should now run.

Note:  If you have multiple network cards in your computer, and you want FEWeld licensed to a
card other than the one provided by gethost.exe, call us.

If you do not have a network in your computer, let us know, we will be providing dongle licensing
soon.

2.2.2. Evaluation Mode

FEWeld runs without a license in evaluation mode.  The following restrictions apply:

o  Weld Formulations cannot be created or edited.

o Files can only be created and edited. Existing files, except sample files as below, cannot be re-
opened.

o  The sample files provided in the distribution can be opened and edited once only.

2.2.3. Training

Weaver Engineering offers training periodically.  Check our website at www.feweld.com or call us
for schedules.

2.2.4. Technical Support

The purchase of FEWeld provides one year of technical support.  After that, annual maintenance
will continue technical support, which also provides continuous updates to the software.

Telephone: (206) 352-8027

Fax: (206) 352-8035

Email: techsupt@feweld.com
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Chapter 3.   Theoretical Overview Excerpts from the Manual
The formulation used for a finite element shell model is that of full penetration welds at every
joint.  Although the loads carried through joints are calculated by FEA, they are not readily usable
for weld calculations.

FEWeld extracts from the fea results load and stress information and presents it in a form that is
readily usable for weld calculations.  Additionally, FEWeld provides a robust mathematical
environment for defining and performing calculations of weld requirements based on the load state
and the performance criteria.

Figure 3-1 A Fillet Welded T-Bracket Illustrating the Terminated
Part and Weld Joint Nodes

3.1. The Terminated Part

Figure 3-1 above depicts a t-bracket constructed from a Part 1 Stem and Part 2 Base.  By
inspection, the Part 1 Stem is the only terminated part in this joint.  The concept of a terminated
part is central to modeling for FEWeld.

The lower right of the figure shows the elements of the stem and the nodes in the weld joint.  The
nodal stresses in these elements at the joint nodes represent the stress state in the stem at the weld.
The z component of the stresses are directly the from the tractions (loads) being transmitted
through the weld.  Specifically, zz�  is due to the combination of the Pz Load and the bending
moments induced by Px and Py. zx� is due to Px transmitted through the weld, and yz�  is due to
Py transmitted through the weld.

From these stress traction components for the element top and bottom and the part thickness, the
load components and bending moment about the weld axis per unit length can be calculated.

On the other hand, for the part 2 base, for elements on either side of the weld joint, the traction
through the element edge associated with the weld joint is a combination of the loads from the
weld and the loads from base plate elements on the other side of the weld.
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For t-joints and lap joints, there is one terminated part for each weld.  For butt and corner joints,
both parts entering the weld are terminated.  Many joint configurations, such as flare-v groove
welds, have no terminated part on their own.  Similar to modeling welds with solid elements, the
weld connection must be modeled with shell elements to create a terminated part. Several
examples of this technique are given an discussed in the FEA Modeling Guidelines, Chapter 5.

Figure 3-2  Weld Joint Coordinate System (wjc) of the Terminated Part

3.2. Weld Joint Coordinate System

Figure 3-2 above shows depictions for a terminated part of a t-joint and a lap joint.  The Weld Joint
Coordinate System (wjc) is defined in terms of the local geometry of the elements with edges in
the joint at each node of the joint.  The three directions of the wjc are:  The Weld Joint Normal, uj,
the Weld Axis, uw, and the Surface Normal, us.  The order of the coordinates is j,w,s.

� The Weld Axis, uw, runs in the direction of the weld seam, and is oriented such that it points in
the counter-clockwise direction around the element top, the same direction as the nodal
sequence of the element definition.

� The Surface Normal, us, is the surface normal of the element ‘top’ at the location where the
weld joint coordinate system is being evaluated.

� The Weld Joint Normal, uj, points directly out of the element edge, in the element plane and
perpendicular to the weld seam.  It is perpendicular to both uw and us.  It is defined by:

.swj

j

s

w

uuu

u
u
u

��

�

�

�

vectorunitnormaljointweld
vectorunitnormalsurface

vectorunitaxisweld

The weld joint coordinate system is calculated in FEWeld locally at each weld joint node based on
the elemental shape function for elements in the terminated part with and edge in the weld joint.
The stress tensor in weld joint coordinates is represented as follows:
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 where the 12, 23, 31 notation is used.
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Figure 3-1 (Reproduced) T-Joint Configuration

3.3. Classical Analysis of Fillet and Partial Joint Penetration Groove Welds

The classical method of sizing fillet welds and
partial joint penetration welds is to divide the load
transmitted through the weld per unit length by the
electrode shear allowable to come up with a
minimum throat size.  The joint is then designed
around the throat requirement.

Calculating the load transmitted through is done by
various means.  The simplest, and most common
method is to calculate the section properties of the
weld treated as a line  – weld throat area, and section
modulus or moment of inertia, and polar moment of
inertia.  Loads are calculated at various points of the
weld using beam bending formula for moments,
dividing the direct axial and shear loads by the area,
and using the Tr/J formula for torsion.  This method
ignores any stiffness effects of the connection.

A sample calculation is presented here using the
weld section properties.  The t-joint of Figure 3-1 is analyzed at the upper-left corner where the
load is the greatest.
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Figure 3-4  Classical Calculation
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Figure 3-3 Weld Load Diagram
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3.4.   Method of Using Loads Calculated from FEA Shell Elements for Analysis of
Fillet and Partial Joint Penetration Groove Welds

Node 340 of the finite element
model depicted in Figure 3-1
corresponds to the top of the
weld joint.  FEWeld load
calculation will be presented at
this node and compared to the
classical analysis.  Refer to
Figure 3-6  .

For this joint, the z axis
corresponds to the negative of
the ‘joint normal’ in the weld
joint coordinates.  Therefore,
only the z stress components are
based on the load transferred
through the weld.

The equations used in classical
analysis to determine part top
and bottom stress due to
bending, normal, and shear loads
are easily reversed to determine
bending, normal, and shear loads

from the stresses.  This is presented for node 340 in Figure 3-6
.  Part C of Figure 3-5 presents the result of this calculation for
every node in the weld joint.

3.5. Weld Section Properties

The weld load calculations shown in Figure 3-6  give the local
weld loads at each node as load per unit length.  For calculating
weld sizes from these results, the section properties per unit
length of weld need to be calculated.

t b

�

�t

b

Resolution of Weld Loads, Node 340:

t b .3
8

in Base Material Thickness

� t .19560 psi Normal Stress at Top of Joint
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� yz_av
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Figure 3-6  Load Calculation for
One Node

Figure 3-5 T-Bracket FEA Stresses and Loads at Joint
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3.6. Weld Throat Stress Calculation

From the weld load components (Tj, Tws, Mw) and the weld
section properties for a given weld size, the weld throat stress
components can be determined as follows:

Stress due to normal load

f
P

Anormal
w
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Stress due to bending:
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w
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Stress due to shear:
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w
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Refer to Figure 3-3.  Note in the total stress magnitude equation that the bending and normal stresses
are combined so that their magnitudes are additive.
This will always be the case on one side of the joint.

In order to compare this result to the classical result,
a further calculation is required:

The loads calculated from FEA (P & V) must be
divided by two since the weld is double sided and the
classical calculation is per unit length of weld and
not per unit length of weld joint which is the
calculation for the FEA presented.
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For evaluation of the weld size, the total stress
magnitude is compared to the electrode shear
allowable, Fa.
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Figure 3-3 (Reproduced) Weld Load Diagram
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3.7. Use of Elastic Stresses as Failure Resistance Predictors
Elastic Stresses are good predictors for high and medium cycle fatigue, loss of dimensional integrity,
and fair proxies for ductile failure.
For resistance against ductile failure, structural plastic behavior comes into play, and can change the
load proportionality significantly.  This is particularly true with restrained single sided welds that are
somewhat small and soft compared to the base metal.  Often, in this situation, there will be local
bending about the weld axis due to elastic rotation of the mated parts.  If the base metal remains
elastic while the weld is yielding, the strain on the weld due to the rotations will not increase nearly
as fast as the strains due to the direct loads, and the joint failure will be aligned with what would be
expected from the direct loads.  However, if the base material becomes plastic, particularly with
respect to rotations, the secondary bending loads should be considered.  If this is an issue in your
design, and you have non-linear FEA, a good method of obtaining an estimate of the plastic
condition at the design ultimate load is to run your model with the predicted ultimate load of the
structure, and perform a FEWeld analysis on that model (With non-linear analysis, FEWeld treats
time steps the same as load cases).
The Pipe_Lug example problem in the next chapter is a good example of a geometry with secondary
bending loads.  Most common forms of classical analysis for ductile failure prediction (throat shear
calculations) do not consider secondary bending of this sort.
The ‘Direct_Shear’ formulation in FEWeld ignores the effects of local joint bending loads, which,
when used for connections of compact sections, results in the same basic weld size calculation that is
performed with classical analysis except that the direct loads are derived from the FEA load path
instead of the nominal values used with classical analysis.
Note:  The AWS D1.1 allowables for throat shear in fatigue (Category ‘F’) are also based on these
nominal values, however, there is a major caveat:  The geometries tested for the development of
these allowables did not involve significant out-of-plane loading, and therefore were not subject to
much local bending about the weld joint.  For designs with out of plane loading and meaningful
local elastic bending about the weld joint, use of effective notch stress concentration factors which
are well described in [1]† is recommended.  FEWeld is well suited to perform nominal, geometric
(Hot Spot), and effective notch stress calculations.
Final notes:  With unrestrained geometries such as the T-Bracket of Figure 3-1, the bending load
will remain proportional with the direct load, and the ‘Direct_Shear’ formulation should not be used.
If a single sided weld is to be used, the formulation should be one of the specific single sided
formulations in the FEWeld library (F1_i, F1_o, P1, P1F1, etc).

                                                
† [1] Hobbacher, A (Editor) 1996.   Fatigue Design of Welded Joints and Components, Recommendations of IIW Joint
Working Group XII – XV.    Woodhead Pub. Ltd.
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Chapter 4.   Example Problems

4.1. Problem 1:  Pipe_Lug

Estimated Time to Perform Exercise:  50 Minutes.

This exercise can be performed in the ‘Demo’ mode of FEWeld.

Weld 02Weld 03

Weld 01

Weld 05a, b
Weld 06

Weld 04

500 Lb Load in Two Parts:

Constant Side Load of 250 Lb

Rotating Load of 433 Lb:
Vertical Down to Horizontal,
Modeled in 15 Degree
Increments

Figure 4-1  Basic Configuration of the Pipe_Lug problem

Figure 4-1  Depicts a lug that is supported by tubing that extends vertically up, then horizontally out.
The lug experiences a load of varying direction from vertical down to horizontal, with a constant
value of 433 pounds with an additional constant side load of 250 pounds for a total constant load
magnitude of 500 pounds.  The weldment is made of aluminum, with the tubing and lug details
made from 6061 and welded with 4043 electrode.  The base plate is made of 5083 and the weld of
the vertical tube to the base plate is with 5356 electrode.

The throat shear stress design allowables against static failure for the electrodes are 5000 psi for the
4043 electrode and 7000 psi for the 5356 electrode.  Welds 01 through 04 are welds of compact
sections and will use the ‘Direct_Shear’ formulation in FEWeld which ignores the local bending
about the weld axis caused by the elastic rotation associated with the out-of-plane loading (Refer to
Section 3.7).  Welds 05 and 06 Will use the ‘DF’ formulation (Balanced, Double Sided Fillet Weld).
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Weld_No Weld Type CS Description Load Case Description
01 Direct_Shear 1 Weld Between Base Plate and Post-Pipe 01 Lug-Load 0 Degrees (Vertical Down)
02 Direct_Shear 1 Weld Between Post-Pipe and Post-Pipe End Cap 02 Lug-Load 15 Degrees
03 Direct_Shear 3 Weld Between Post-Pipe and Stand-Off Pipe 03 Lug-Load 30 Degrees
04 Direct_Shear 3 Weld between Stand-Off Pipe and Lug-Plug 04 Lug-Load 45 Degrees

05a F1_o 0 Weld between Stand-Off Pipe and Lug - Top 05 Lug-Load 60 Degrees
05b F1_o 0 Weld between Stand-Off Pipe and Lug - Bottom 06 Lug-Load 75 Degrees
06 F1_o 0 Weld Between Lug-Plug and Lug 07 Lug-Load 90 Degrees (Horizontal)

Figure 4-2  Welds and Load Cases in the Pipe_Lug_01 Model

Exercise Objectives:
1) Predict the fillet weld size requirements for the Pipe_Lug structure from the solved FEA

model.

2) Determine the effect on the weld sizes of changing the wall thickness of the Part 2 (vertical)
tube from 0.25 inch to 0.50 inch.

Exercise Task Summary:
1) Solve the Pipe_Lug_01 FEA Model that is provided on the CD or Download (5 Minutes)

2) Create a new FEWeld file, Pipe_Lug.wld, and Build the FEWeld Weld Set for the
Pipe_Lug_01 FEA Configuration, and run the FEWeld Analysis (20 Minutes)

3) Review and Browse the Results (10 Minutes)

4) Create a new FEA Model called Pipe_Lug_02 by copying the Pipe_Lug_01 model (or Reuse
the Pipe_Lug_01 model), change the thickness of the vertical post to 0.50 and solve. (5
Minutes)

5) Create a new Weld Set, Pipe_Lug_02, in the Pipe_Lug FEWeld file by copying the
Pipe_Lug_01 Weld Set, and run the FEWeld Analysis. (1 Minute)

6) Review and Browse the Results (10 Minutes).

4.1.1. Task 1: Solve the Pipe_Lug_01 FEA Model that is provided on the CD or Download.
(5 Minutes)

The distribution (CD or Download) that contains the FEWeld Program also contains the Pipe_Lug
Example problem in the ‘FEWeld_Samples\Pipe_lug’ directory.  This directory contains
subdirectories for Ansys and Cosmos.

For Ansys, Create a new model called ‘Pipe_Lug_01’ in the ansys directory.  The Pipe_Lug_01.db
is a built by issuing the ‘CDREAD,COMB,Pipe_Lug_01,cdr’ command. Issue the ‘LSSOLVE,1,7,1’

For Cosmos, the directory contains Pipe_Lug_01.gfm.  Create a new model in cosmos called
‘Pipe_lug_01’ in the cosmos directory, and issue the following command from the Cosmos console:
‘file,pipe_lug_01.gfm,0,1,0’.  This file will build and run the fea model.

Note:  The model takes 3 minutes to solve in cosmos 2.5 using the sparse matrix direct solver on a
450 MHz Pentium II with 256 Meg of ram.
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4.1.2. Task 2: Build and Run the FEWeld Model
Create a new FEWeld file, Pipe_Lug.wld, and Build the FEWeld Weld Set
for the Pipe_Lug_01 FEA Configuration.

Step 1: Set the Default FEA System for FEWeld

Start FEWeld. Each FEWeld file has a FEA System setting. Now is a good
time to set the default FEA system for new files.

Select the File >> Options… menu command.  The Options dialog will
appear as in Figure 4-3.  Select your preferred FEA System.  You can set
the FEA system for individual files also, with the Analysis >> Select FEA
System menu command when a FEWeld file is open.  In
addition to affecting the command file format, the fea
system setting affects the input for defining the weld nodes
and elements in the weld definition window.

Step 2:  Create a new FEWeld File

Select the File >> New menu command.  Navigate to the
Sample_Problems\Pipe_Lug Directory.  Type in file name
such as Pipe_Lug and hit OK.  The new FEWeld file will
be created and opened.  The screen should look like Figure
4-4

Step 3:  Create a new Blank Weld Set

In the New Set Dialog of Figure 4-4, Type in
Pipe_Lug_01 for the Set Name and ”0.25 Thick Wall
Post, Quadratic Displacement Formulation FEA
Model” for the description and click Accept.

The New Set Dialog will close, and the Weld_Set main
window will appear as shown in Figure 4-5.

Step 4: Populate the Weld Set with Weld,  Load
Case, and Criteria Definitions

The Weld_Set main window is free-form in that there is
no required order for putting in welds, load cases, and
Stress Allowable Sets.

Entering The Welds:

Since there are 7 welds (counting welds 05a and 05b
separately), you may want to enlarge the welds section of the form.  Do this by dragging the divider
bar at the bottom of the weld list downward while holding down the mouse button (Item 1, Figure
4-5).  Also experiment with resizing the window width and height.

Refer to Figure 4-2 and, using ‘Direct_Shear’ formulation (for static analysis of connections of
compact sections), type the Weld Number, Weld Type, and  Description into Weld Grid section
(Figure 4-5, Item 2) for the 7 welds1.

                                                
1 Tip:  After the first weld is entered, in each field of subsequent records, depressing <ctrl-“> (ditto) fills the current field
with the value of the same field of the previous record.

Figure 4-4 New FEWeld File

Figure 4-5 Empty Weld Set,
The ‘Main Window’

Figure 4-3  FEA Default
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Entering the Load Cases:

There are 7 Load Cases and two electrode materials with different stress allowables.   Since most
problems involve a single electrode material, we will start with the allowables for 4043, and add the
5356 later. Refer to Figure 4-2.  Into the Load Case Grid (Figure 4-5, Item 3) try entering the load
case by columns instead of rows:  Enter the load case numbers into the form, Load Cases 01 through
07, followed by the descriptions, then the stress allowable for 4043 (5000 psi).  Depressing the
return key moves to the next load case while hitting the tab key moves to the next field of the current
load case.  (Load case numbers must be entered as they are represented in the FEA system, however
leading zero’s are o.k., and advised since FEWeld sorts entries in alphabetic order).

   
Part A:  Before Stress Allowable Definition Part B:  After Stress Allowable Definition

Figure 4-6    Defining Stress Allowable Sets

Defining Multiple Stress Allowables for the Same Load Case:

Because this weldment will be fabricated with both 4043 and 5356 electrodes, different welds will
have different allowable throat stresses for the same load cases.  In order to accommodate this,
‘Stress Allowable Sets’ must be defined.

Click the *
aF  button in the main window (Figure 4-6, Part A Item 1) or select the

Definition >> New Allowables Set menu command.  The appearance of the main window will change
to show the area for stress allowable sets as shown in Figure 4-6, Part B, Items 2, and 3. Note that
when the Stress Allowables Grid is Opened, there is a stress allowable set called 01 already there.
Rename that to 4043 and observe what happens in the allowables set part of the weld grid (Item 3),
and in the Allowable Stresses part of the Load Case Grid (Item 4).  Next, add a 5356 Allowables Set
in the Stress Allowable Sets Grid (Item 2).  Change the allowables set for weld 01 in the weld grid to
5356 (Item 3), and add the allowable stress values (7000 psi) in the 5356 column of the Load Cases
grid (Item 4).
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Step 5: Provide Weld Detail Data for Each Weld: Terminated Part Element Selection and
Weld Joint Node Selection And Weld Parameters

Open the weld definition window by clicking the ‘weld definition’ button, , in the weld set main
window (Figure 4-5, Item 4), by selecting the Definition>>Weld Detail menu command, or by double
clicking on a weld number or description in the weld list, Items 2 and 3.  (Double clicking the weld
type brings up the formulation editor for that weld type.)

Figure 4-7 Shows the weld definition data window.  If it is not set to Weld No 01, either press the 
button or click anywhere on the Weld 01 row in the Welds grid of the Weld Set main window.
Notice that this weld is not ‘defined’.  A weld becomes defined when there is sufficient information
provided to put out a valid FEA command file for that weld into
the appropriate FEA system.  For Weld 01, the Weld Node
Selection Curve List and the Shell Element Geometry List are
highlighted in red.  This information is needed to complete the
definition for weld 01.

Note, rather than defining the welds in the main window as we
did, they can also be defined in this form.

We will go through the items below the weld type one by one.

Orientation:  Many weld types require the element orientation
with respect to where the weld will be laid – some balanced
formulations, such as equal double sided fillet welds ‘DF’, and
the ‘Direct Shear’ don’t care about the orientation, and the
orientation is not required for those welds.

Ansys Cosmos Femap

Figure 4-8  Ansys and Cosmos Plots Colored to Show Element Orientation.

The Pipe_Lug_01 model was meshed with the positive element normals pointing outward and up.
Figure 4-8 shows filled, colored element plots from Ansys and Cosmos with the element orientation
identified by color.  (If you are looking at this in black and white, the Cosmos plot is difficult to
distinguish, the positive faces are colored red and the negative faces are colored blue.)

When you are curious about a formulation, double click on the weld_type field in the main window
or in the Weld Definition Data window, or alternatively, issue the Definition>>Library Formulations
menu command and select the formulation from the list on the left.

Figure 4-7 Weld Definition
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Figure 4-9  The Weld Formulation Editor and Diagram Windows showing the F1_i Formulation.

Weld Parameters:

The next item in the weld definition data form is the undefined weld parameters.  The default values
for the Direct_Shear and DF formulations are a 45 degree fillet and no minimum size (0.).

Coordinate System:  (Optional):

The coordinate system is an optional parameter.  It is used for weld joint nodal position listings only.
If none is specified, then the global Cartesian system is used (0).  For the pipe lug problem, Welds
01 and 02 should use Csys 1 (the global cylindrical system), Welds 03 and 04 should use Csys 3, a
cylindrical system defined in alignment with the stand-0ff pipe, and welds 05 and 06 should use
Csys 0.

Weld Joint Definition – Nodes and Elements:

There are several approached for specifying the weld joint nodes and terminated part elements.  In
Ansys, it may be expedient to build components or groups and put the nodes and elements in them
for each weld and just specify the groups.  Or, the curves (lines) for the weld joint nodes, and the
surfaces, areas, etc, for the terminated part elements could be listed a priori and filled into the form.
The method presented here will be to fill in the form interactively, querying the FEA entities and
putting them into FEWeld one weld at a time.

Open the Pipe_Lug_01 FEA model in your FEA application. Switch to the FEWeld application after
the Pipe_Lug_01 fea model is opened.  The Weld Definition Data window can float outside the
FEWeld application window.  Make the FEWeld application window small as shown in Figure 4-10.
(Size it small, do not minimize it, minimizing the FEWeld application window will remove the weld
definition data window.)



FEWeld Chapter 4. Example Problems 4-7

 
Figure 4-10  Interactive Weld Definition

With the screen setup similar to Figure 4-10, interactively entering the weld definitions is fairly
simple. Table 4-1 and Table 4-2 give useful commands for Ansys, Cosmos, respectively, for
querying the FEA model for Point, Curve, Surface, Area, etc. ID’s.

Entity Command Line Menu Description

Points KLIST,P…

KSEL,S,P…
KLIST,ALL

List>Picked Entities>Keypoints…

Select>Entities…->Keypoints
List>Keypoints…

Pick Points and List

Select Points and List

Lines LLIST,P…

LSEL,S,P…
LLIST,ALL

List>Picked Entities>Lines…

Select>Entities…->Lines
List>Lines…

Pick Lines and List

Select Lines and List

Areas ALIST,P…

ASEL,S,P…
ALIST,ALL

List>Picked Entities>Areas…

Select>Entities…->Areas
List>Areas…

Pick Areas and List

Select Areas and List

Table 4-1 Ansys Useful Query Commands

Entity Command Line Menu Description

Points PTID…

INITSEL,PT;
SELPIC,PT…
PTLIST;

Geometry>Points>Editing>Identy

Control>Select>Initialize->Points
Control>Select>By Picking …
Geometry>Points>Editing>List

Query Point

Select Points and List

Curves CRID…

INITSEL,CR;
SELPIC,CR…
CRLIST;

Geometry>Curves>Editing>Identy

Control>Select>Initialize->Curves
Control>Select>By Picking …
Geometry>Curves>Editing>List

Query Curve

Select Curves and List

Suraces SFID…

INITSEL,SF;
SELPIC,SF…
SFLIST;

Geometry>Surfaces>Editing>Identy

Control>Select>Initialize->Surfaces
Control>Select>By Picking …
Geometry>Surfaces>Editing>List

Query Surface

Select Surfaces and List

Regions RGID…

INITSEL,RG;
SELPIC,RG…
RGLIST;

Geometry>Regions>Editing>Identy

Control>Select>Initialize->Regions
Control>Select>By Picking …
Geometry>Regions>Editing>List

Query Region

Select Regions and List

Table 4-2 Cosmos Useful Query Commands
The set of entities for the weld definitions is listed in Table 4-3. Move between welds in the Weld
Definition window with the right and left arrow buttons at the top right, .
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When entering data in the curve list or surface list, pressing <ctrl-tab> will move you out of the list
without the mouse.

As the Welds become fully defined, their status is updated in the main window.  See Figure 4-11,
Items 1 and 2.

Figure 4-11  Weld Definition Status in the Main Window

Step 6:  Generate the FEWeld-FEA Command/Macro File

When the FEWeld definition for the
Pipe_Lug_01 weld set is complete, FEWeld is
ready to write out the FEA Command file.
Note that the ‘Write Command File’ button in
the main window has become enabled (Figure
4-11, Item 3).

The write_fea_cmd_File command is invoked
either by it’s button, item 3 in Figure 4-11, or
with the Analysis>>Write FEA Cmd File menu
command.  A save-file dialog comes up and
the default name for the command file is
set_name_feweld.cmd where .cmd is .mac for
Ansys and .geo for Cosmos, and set_name is
the name of the current weld set.  For
example, the command file name for Cosmos
output for Pipe_Lug_01 is
Pipe_Lug_01_FEWeld.geo.

It is recommended to put the command file in
the directory that contains the FEA model
because that is where FEWeld looks for the
FEWeld results file that is generated by the
command file.  The relative path from the
FEWeld file to the location where the
command file is written is stored with each
weld set, so that FEWeld will look in the
correct location if the job directory is moved.

Write the FEA Command File now.

Ansys CosmosWeld
No Lines Areas Curves Surfaces
01 9

10
11
12

2
3
4
5

70
75
79
82

SF 1
SF 2
SF 3
SF 4

02 46
47
48
49

20 8
11
13
58

SF 215
SF 216
SF 217
SF 218

03 33
34
36
60
61
71
72
73

11
13
15
17

36
43

151
153
197
200
244
247

SF 87
SF 89

SF 124
SF 125
SF 147
SF 148
SF 170
SF 171

04 37
38
39
40

18
21

45
46

141
144
182
184
230
231

SF 17
SF 33

SF 118
SF 119
SF 141
SF 164
SF 165
SF 201

05a 92 19 15 SF  25
05b 94 19 16 SF  26
06 55 19 25

26
27
31

SF 25
SF 26
SF 27
SF 28

Table 4-3  Pipe_Lug_01 Weld Geometric Entities
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Figure 4-14

Step 7: Execute the Command/Macro File in the FEA Environment

If your FEA program is not open in the Pipe_Lug_01 model, open it now.  Executing the command
file is very simple.  See Table 4-4.

FEA Program Command Line Menu Command
Ansys /INPUT,FNAME,EXT,DIR File>Read Input From…
Cosmos FILE1 File>Load…

Table 4-4 Commands to execute FEA command/macro/script files

Execute the Yoke_01_FEWeld.xxx FEA Command file now.  Depending on the speed of your
computer, the script should take 1 to 5 minutes to run.

The FEA Command File created a file called Yoke_01.fewinp in the FEA problem directory.  This
will be read into FEWeld.

Step 8 Read the Weld Results into FEWeld

Read the Weld Results into the FEWeld file by
clicking the Read Results Button, Item 1 in
Figure 4-12 or with the
Analysis>>Read FEA Results menu command.

A standard windows file read dialog will appear
as shown in Figure 4-13.  When this file is
opened, FEWeld will begin calculating the weld loads and weld formulations.  A progress dialog
will display the calculation status.  For a large model, this can take a little while, although generally,

it is much faster than the original FEA

solution.
Troubleshooting:  If there was a gross error in the weld definition such that there is no association
between the weld nodes and elements, the calculation will stop with an error message as shown
Figure 4-15.  FEWeld attempts to catch errors and give descriptions.  Some descriptions are more
helpful than others.

For example, say that you entered curve
no 16 instead of 15 for Weld No. 05a.

                                                
1 For Cosmos, just typing the file command and pressing return will bring up the standard windows file read dialog box
to browse and pick the file.  Or, type in the filename:  FILE, Pipe_Lug_01_FEWeld.geo;

Figure 4-12

Figure 4-13

Figure 4-15
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To identify the error, open the weld definition data window for weld 05a.  Either manually query the
curves and areas/regions/surfaces or write out a test weld FEA command file, by clicking the ‘Test
Weld Geom’ button, Item 1 in Figure 4-16.

The ‘Test Weld Geom’ command will write out a file titled Pipe_Lug_01_W05a_FEWeld.cmd
where .cmd  is .mac for Ansys and .geo for Cosmos.  Executing this file in the FEA program should
select and display the Geometry (Curves/Lines, Areas, Surfaces, Regions, etc) selected for the weld
and their associated Terminated Part Elements and Weld Joint Nodes.  Repair
the definition and return to Step 6:  Generate the FEWeld-FEA
Command/Macro File.

Figure 4-18  Result of running Pipe_Lug_01_W05a_FEWeld.geo
in Cosmos

Step 9 Review the Results for Joint Definition
Correctness.

Open the Detail Results Charting Window by
clicking the chart button in the Weld Set main
Window, Figure 4-17, Item 1, that becomes enabled after
results for the Weld Set are successfully read in.  or by
selecting the Results>>Detail Results menu command.

Configure the chart control panel so that it sequences
through the welds first, as arranged in Figure 4-19.  Do
this by clicking the load case toggle, Figure 4-20, Item 1,
and moving the load case position as shown below.

Figure 4-20  Rearranging the Chart Sequence

Now, scroll through the welds looking at the length and
the coordinates to see if they make sense.  Figure 4-19
shows the plot for Weld No 01, except that curve number 81 was used in the definition instead of
curve 82.  This weld definition would need correction.

Figure 4-17

Figure 4-19

Figure 4-16
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4.1.3. Task 3:  Review and Browse the Results (10 Minutes)

There are 2 basic levels of results review:  Summary reports and detail charts.

Summary Reports

There two summary reports available in FEWeld:  Results Summary by Weld and Results Summary
by Load Case.  They are both accessed under the Results menu.

0.25 Thick Wall Post, 1.0 Thick Base, Quadratic Displacement Formulation FEA Model

Set Description

Load Case Data: Load Case Count 7

Allowables Sets: Allowables Sets Count 2

Load Case - Allowables Crosstab:

Results Summary by Weld for Set: Pipe_Lug_01
July 01, 2000 Page 1 of 2File:  G:\Work\91-011\Models\Pipe_Lug_Practice\Pipe_Lug.wld

LC Description
01 Lug-Load 0 Degrees (Vertical Down)

02 Lug-Load 15 Degrees

03 Lug-Load 30 Degrees

04 Lug-Load 45 Degrees

05 Lug-Load 60 Degrees

06 Lug-Load 75 Degrees

07 Lug-Load 90 Degrees

Load Case 4043 5356
01 5000 7000

02 5000 7000

03 5000 7000

04 5000 7000

05 5000 7000

06 5000 7000

07 5000 7000

ID Description
4043 4043 Electrode

5356 5356 Electrode

ValueNode
Allowable
Stress

Load 
Case Criteria

Weld Data: Weld_Count 7 entered with 7 Calculated

01 Weld Between Base Plate and Post-Pipe aWeld
Basic Weld Throat Determined By Shear from Direct Loads.  
(Local Bending Ignored)

Sa_Set_No: 5356DIRECT_SHEAR

face_angle_deg 45

min_leg_size 0

04 .21556337000S1 “Fillet Leg Size on Terminated Part 
(if fillet weld)”

Max Signed

04 .15256337000tw Weld Throat, (a), from Direct Loads 
Only

Max Signed

02 Weld Between Post-Pipe and Post-Pipe End CapWeld
Basic Weld Throat Determined By Shear from Direct Loads.  
(Local Bending Ignored)

Sa_Set_No: 4043DIRECT_SHEAR

face_angle_deg 45

min_leg_size 0

01 .06671495000S1 “Fillet Leg Size on Terminated Part 
(if fillet weld)”

Max Signed

01 .04671495000tw Weld Throat, (a), from Direct Loads 
Only

Max Signed

03 Weld Between Post-Pipe and Stand-Off PipeWeld
Basic Weld Throat Determined By Shear from Direct Loads.  
(Local Bending Ignored)

Sa_Set_No: 4043DIRECT_SHEAR

face_angle_deg 45

min_leg_size 0

01 .33787855000S1 “Fillet Leg Size on Terminated Part 
(if fillet weld)”

Max Signed

01 .23987855000tw Weld Throat, (a), from Direct Loads 
Only

Max Signed

04 Weld between Stand-Off Pipe and Lug-PlugWeld
Basic Weld Throat Determined By Shear from Direct Loads.  
(Local Bending Ignored)

Sa_Set_No: 4043DIRECT_SHEAR

face_angle_deg 45

min_leg_size 0

07 .109113285000S1 “Fillet Leg Size on Terminated Part 
(if fillet weld)”

Max Signed

07 .077113285000tw Weld Throat, (a), from Direct Loads 
Only

Max Signed

     

Results Summary by LC for Set: Pipe_Lug_01
July 01, 2000 Page 2 of 4File:  G:\Work\91-011\Models\Pipe_Lug_Practice\Pipe_Lug.wld

ValueNode
Allowable
Stress Criteria

Weld Data: Weld_Count 7 entered with 7 Calculated

02
Weld Between Post-Pipe and Post-Pipe End Cap

Weld

Basic Weld Throat Determined By Shear from Direct Loads.  (Local 
Bending Ignored)

Sa_Set_No: 4043DIRECT_SHEAR

face_angle_deg 45

min_leg_size 0

Load Case: 01 Lug-Load 0 Degrees (Vertical Down)

.06671495000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.04671495000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 02 Lug-Load 15 Degrees

.06471495000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.04571495000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 03 Lug-Load 30 Degrees

.0671495000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.04271495000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 04 Lug-Load 45 Degrees

.05371495000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.03871495000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 05 Lug-Load 60 Degrees

.04571495000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.03271495000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 06 Lug-Load 75 Degrees

.03771485000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.02671485000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 07 Lug-Load 90 Degrees

.03371475000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.02471475000tw Weld Throat, (a), from Direct Loads Only Max Signed

03
Weld Between Post-Pipe and Stand-Off Pipe

Weld

Basic Weld Throat Determined By Shear from Direct Loads.  (Local 
Bending Ignored)

Sa_Set_No: 4043DIRECT_SHEAR

face_angle_deg 45

min_leg_size 0

Load Case: 01 Lug-Load 0 Degrees (Vertical Down)

.33787855000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.23987855000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 02 Lug-Load 15 Degrees

.32687855000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.23187855000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 03 Lug-Load 30 Degrees

.30887855000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.21887855000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 04 Lug-Load 45 Degrees

.28487855000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.20187855000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 05 Lug-Load 60 Degrees

.268101235000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.19101235000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 06 Lug-Load 75 Degrees

.269101225000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.19101225000tw Weld Throat, (a), from Direct Loads Only Max Signed

Load Case: 07 Lug-Load 90 Degrees

.276101225000S1 “Fillet Leg Size on Terminated Part (if 
fillet weld)”

Max Signed

.195101225000tw Weld Throat, (a), from Direct Loads Only Max Signed

Figure 4-21  Results by Weld and Results By Load Case Reports

In Figure 4-21, the report on the left is the Results By Weld report.  It contains the most distilled
summary of the analysis.  It presents only the worst case single value of each summarized variable
for each weld, along with the node, load case, and criteria (allowable stress).
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The report on the right is the Results By Load Case report.  This report shows for each load case the
worst case single value of each summarized variable along with the node, and criteria.

Detail Charts

The detail chart will plot stored variables from the weld formulation along the weld joint.

Figure 4-22 The Detail Weld Results Tools

Some items about the detail chart to briefly note:

Item 1:  The Select Results button brings up a dialog to select Weld Sets, Welds, and Load Cases the
the Detail Results Control Panel will Browse through.  Note two special entries in the load case
column:  ByNode and ByWeld.  ByNode plots at each node the value for the worst case load case of
the summarized variable (Note the ‘Summary Variable’ in item 2).  ByWeld plots the results for the
single load case that resulted in the worst single value of the summarized variable.  Note also in the
Control Panel, the buttons for Print and Export.  These are for batch printing charts, and exporting
results for specific charts.

Item 2:  The chart.  Clicking on the chart area will open the Weldtype Plot Variables window for
selecting which variables get plotted and which summary variable is used for the byNode and
byWeld plots.

Item 3:  The scrolling buttons in the
Control Panel.  Browse through the
welds and load cases.

Item 4:  Click the mouse on s, x, y,  or
z, and that will become the independent
variable in the chart.

Pipe_Lug_01, Weld: 06, LC: 07
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Note Weld No 06.  The weld size is a little small, let’s try a single sided weld.

Switch over to the Main Window (Using the Window menu or closing the chart window if
necessary).  Change the weld type for Weld No 06 to F1_o.  Notice that if the chart was open, it is
immediately closed, and the defined status of Weld No 06 is now ‘Undefined’ (The weld is un-
checked).

Open the Weld Definition Data Window,  , (refer back to Task 2, Step 5), and set the restraint for
Weld No 06 to 1 (In the upper and lower ½ inch, the joint will have a fair degree of restraint (against
rotation) due to the adjacent, perpendicular Welds No 05).

Now, Open the detail chart window, .  This will cause  recalculation dialog to be opened.
Unselecting any items in the calculation list will skip calculation for that item and that weld will
remain in the recalculation list and be unavailable for post
processing until it is recalculated in the future.  Leave Weld 06
selected and click the Go button.  Weld No 06 will be
recalculated with a restraint factor of 1, and the chart will be
displayed.

Pipe_Lug_01, Weld: 06, LC: byNode
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Figure 4-23

The resulting byNode chart for Weld 06 is shown in Figure 4-23.  The required single sided weld
size is quite large.  Without closing the chart, change the weld type back to ‘DF’ in the Weld Set
main window or the weld detail window.  Weld 06 will be immediately recalculated.

4.1.4. Task 4:  Run the Pipe_Lug FEA Model with the Vertical Post Wall Thickness
Changed to 0.50 (5 Minutes)

Either copy the Pipe_Lug_01 FEA model to Pipe_Lug_02 and revise property set 2 to 0.50 thickness
or just revise the existing model and resolve the problem.

4.1.5. Task 5: Create a new FEWeld Weld Set in the Pipe_Lug file and Run the Analysis

Figure 4-24

Close the Result Windows.  In the Weld Set Main Window, Click the New Weld Set Button, ,
Figure 4-24, Item 1, or Select the Definition>>New Set Menu Command.  The New Set window will
appear as shown below in Figure 4-25.
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Figure 4-25

Make the new set name ‘Pipe_Lug_02’, and select
Pipe_Lug_01 from the Copy From Set drop down
list.  Revise the description to note the new material
thickness, and click accept.

The new weld set, Pipe_Lug_02 is created that is an
exact copy of Pipe_Lug_01, except there are no
results.  No revision is necessary since the weld and
load case definitions are remaining the same.
Repeat task 2, Steps 6 through 8 to write out the
FEA Command file, execute it, and load the results
back into FEWeld.

The welds that are interesting with this wall
thickness change are Welds No 01 through 03.

Weld_No First Weld Description Weld_Type for
First Set

Var Name Pipe_Lug_01 Pipe_Lug_02

01 Weld Between Base Plate and Post-Pipe a DIRECT_SHEAR S1 .215 .216
02 Weld Between Post-Pipe and Post-Pipe End Cap DIRECT_SHEAR S1 .066 .047
03 Weld Between Post-Pipe and Stand-Off Pipe DIRECT_SHEAR S1 .337 .234
04 Weld between Stand-Off Pipe and Lug-Plug DIRECT_SHEAR S1 .109 .109

05a Weld between Stand-Off Pipe and Lug - Top DF S1 .171 .171
05b Weld between Stand-Off Pipe and Lug - Bottom DF S1 .376 .376
06 Weld Between Lug-Plug and Lug DF S1 .262 .262

Table 4-5  Summary of Results ByWeld Across the Weld Sets

Table 4-5 Shows a summary of the results.  This was generated with the
Results>>Results Sum ByWeld / Set Crosstab menu command.

    
Figure 4-26 Selecting Specific Welds for Review

Open the Detail Weld Results (Chart) Window, and click the Select Results… button to bring up the
Results Selection Window as shown in Figure 4-26.  Clear all of the weld selections then select
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welds 02 and 03.  Next, reorder the positions in the ‘Detail Results Control Panel’ so that load cases
are leftmost, welds in the middle, and sets at the right (See Figure 4-20, Step 9, Task 2).

Now the control panel will sequence across the weld sets first (corresponding to the FEA models),
followed by the welds, and last, the load cases.
Weld Pipe_Lug_01 Pipe_Lug_02

02 Pipe_Lug_01, Weld: 02, LC: byNode
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03 Pipe_Lug_01, Weld: 03, LC: byNode
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Figure 4-27  Result Plots for Welds 01 through 03

4.1.6. Concluding Notes for the Pipe Lug Example.

Fatigue:

If you perform fatigue analysis, then the analysis just presented is sufficient for determining the fillet
sizes for adherence to the published ‘throat shear’ allowables for fatigue, however, for evaluation
against base material allowables based on the ‘hot spot’ method (also known as the structural stress
method or geometric stress method), further evaluation is necessary.  One of the Weld Formulations
(Weld Types) in FEWeld is called ‘Stress’ .  This formulation simply outputs the base metal stress
tensor on each side of the terminated part in weld joint coordinates.  The transverse stresses can be
compared against category E or X2 (AWS D1.1) or other base metal fatigue allowables.  There is
also the ‘notch trans’ formulation to apply effective toe and root notch stress concentration factors
for membrane and bending loads to output the worst case effective notch stress due to transverse
loads (you supply the effective notch stress concentration factors as weld parameters).  For fatigue,
additional welds would need to be defined for the Pipe_Lug example to look at the base metal stress
at all material load paths passing through or past the weld joint.
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4.1.7. Classical Calculation for Weld 01, Load Case 04:

      

The fillet size calculated in FEWeld was .215 inch, a difference of 10%.  Figure 4-28 shows the
weld loads calculated from the FEWeld analysis.  Note, however, if the base plate is changed to 0.50
inch, FEWeld predicts a maximum weld size of .265 inch.  This is a real effect due to the additional
softness of the base plate toward the center that is not accounted for with classical analysis.
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Pipe_Lug_03, Weld: 01, LC: 04
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Figure 4-28  Load Plots From FEWeld for Weld 01, Load Case 04, .25 and .50 thick vertical post
with 1.0 inch Base, .25 vertical post with 0.50 inch Base.

4.2.   Example Conclusion:

This example exercised many of the features of using FEWeld for analysis of welds.  Even so, the
analysis is fast, the more so once you learn to move around the program.  The weld loads for the
problem presented are readily calculated with classical analysis.  Performing classical analysis on
this weldment would take some time, however.  Several of the welds may have to be calculated at
more than one load condition to determine the worst case.  Often, with complex weldments,
calculating the load distribution along the weld joint using classical analysis is difficult.

Future Enhancements:

� FEWeld will have facilities for general load
case interactions that are intended to be able
to handle user specifications from simple
Goodman diagrams, to nonlinear interaction
formulae, to cycle counting methods.  This
facility will be general, just like the weld
formulation language is general.

� Simple Load Path Accounting for applying
effective notch stress concentration factors
multiple load path joints such as to cruciform,
T, and Lap Joints.

Other:
The FEWeld user manual covers the material
introduced here in much greater depth.  It is ~180
pages in length.
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